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Introduction Exsion Reporting for Business Central Online

Exsion Reporting BC is an addition in Excel that has been specially developed to be able to present figures from Dynamics BC administrations 
quickly (real-time) and easily. By combining the functionality and presentation power of Excel with a real-time link to the reliable figures from your 
administration, you can request data for different companies and over different periods at any time, within a few seconds. With Exsion Reporting 
BC you are no longer dependent on the static reporting format of Dynamics BC, but you can determine yourself how a report is divided into a 
presentation format to be determined by you. The use of colors and graphs considerably increases the presentation value. If overviews have 
already been created in Excel in a certain form in which the data must be entered or copied again each period, these can easily be transferred to 
Exsion Reporting BC overviews.

In short: Exsion Reporting BC offers time saving, information and ease of use without extra processes, from different accounts and even from 
different databases.
This manual uses the Cronus Demo database. However, you can simply run the commands on your own database.

This manual is structured as follows:

Chapter 2 shows a clear overview of the Exsion Reporting BC menu
Chapter 3 explains the Exsion functions
Chapter 4 covers downloads
Chapter 5 shows an overview of the use of pivot tables
Chapter 6 exercises

Chapter 2 -  Exsion Reporting BC-menu

When Exsion Reporting BC is installed, your Excel menu bar is extended with the Exsion Reporting BC menu.
The menu is activated by clicking once on the Exsion Reporting BC menu. You will then see the following menu.

This chapter does not cover the Download item.
This is discussed in the next chapter.



Connection

In order to use Exsion Reporting BC, a connection must be defined. A connection is a connection to a company (or administration) in a database.
A connection must therefore be defined per company. Exsion Reporting BC stores the defined connections.

On the Exsion Reporting BC menu, click Connection.

You will then see the following screen:

In this screen, the URL is entered and you choose the type of Access key or Windows.
With access key type you can use your username with access key code for web service to log in.
When this is entered correctly, the language code can be selected last.

Refresh data

Refresh data is an option to update the data in the report. Imagine that you have developed a report that shows the current stock level.
When one of your colleagues makes a change to the stock, you no longer have the current state of affairs.
If you click on , the current data will be retrieved and placed in the worksheet.<Refresh data>

Help

CLick the Help button to get online Help for using Exsion BC.



Info

The Info screen provides information about:

Settings: See explanation below
Support: possibility to start TeamViewer for support via helpdesk
Version: Exsion Reporting BC version (Current installed version)
License: Licenses in use

Select the Language you want to user for the Exsion BC interface.

Show details can be applied by selecting a cell in which an Exsion function is present and then clicking on <Show details> In the Exsion BC 
menu.
Using this option, you can either open the Web client and go directly to where Exsion collected the data or display the details in Excel.
This allows you to quickly check whether you have used the correct function with the correct parameters.
If the formula shows a balance, this option will show a breakdown of the balance, by showing the individual entries in the Web client / Excel.

Chapter 3 - Exsion functions

Before you can apply Exsion functions, at least one connection must be defined (see previous chapter).
The Exsion functions are inserted in the same way as the standard Excel functions.
If you use functions often, you can enter them manually.
If you are not sure how the function is structured, you can do this via the "Formulas" tab and then the <Insert function> button.

Tip: Automatic calculation



The Exsion functions are in direct contact with the database. Click on <File> at the top left and then <Options> and then select the "Formulas" 
tab.
You can then indicate in the calculation options that formulas should be calculated automatically. This applies to Exsion functions and Excel 
functions.

Insert function

Open the  tab and click the  button, or click the  button on the left side of the formula bar."Formulas" <Insert Function> <Insert Function>
Select here the category  and the function "ExsionBC Standard" "EXSIONBC_COMPANY"
You will then see the following window:

Click on <OK> and you will arrive at the screen below.

At Company you enter the name of the company (CRONUS NL) that you can retrieve from Business Central through the Companies list (see 
image below).



As a result of this function, the display name will be displayed (in this example CRONUS NL (Display Name)).

Add function to report sheet

Using the 15 predefined functions it is possible to build a number of reports.
This section describes how we create a customer overview.
The methodology for a supplier overview is the same, where 'CUS' from the functions is replaced by 'VEN'.

To create a simple customer overview we use the following functions:
EXSIONBC_CUSNAME(): returns the customer name
EXSIONBC_CUSCITY(): returns the customer residence
EXSIONBC_CUSBAL(): returns the customer balance, it is possible to apply a date filter to this function.

Create a customer overview with at least 4 customers according to the layout below.
Use customer numbers from your own database.
Enter at least four customer numbers in column B (the numbers in the example are from the Cronus database).
Retrieve the data (Name, City and Outstanding balance) using Exsion functions. let's disregard the date filter for now.

Select the cell to the right of the customer number (cell C5) and click on <Insert Function> and select ExsionBC_CUSNAME and click OK



Enter Company and refer to the Customer No. in column B.
Press OK and the customer will be displayed.
This formula can be extended downwards.

Doe ditzelfde nu voor de Plaats en Saldo met de functies ExsionBC_KLTWPL en ExsionBC_KLTSAL.
Met de gegevens uit het bedrijf CRONUS NL komen nu onderstaande gegevens naar voren.



To create a general ledger account overview, ExsionBC offers the following functions:
EXSIONBC_ACCNAME(): returns the description of a general ledger account.
EXSIONBC_ACCBAL(): returns the balance of a general ledger account. It is possible to apply a date filter to this. It is also possible to filter on 
dimension 1 and dimension 2 (usually cost center and cost unit).
EXSIONBC_ACCTOT(): returns the composition of a total account (eg 1000..1199)

Chapter 4 - Download

In the previous chapter, customer numbers and general ledger account numbers were always entered manually.
However, when the reports become larger, it is no longer efficient to enter this data manually.
This process can be replaced by a download of data. A download always consists of a download definition and the output (the result).
Changes that affect the output must therefore always be indicated in the definition.

Dynamic download wizard

To create a new download definititon, click the  button.<Dynamic download>



The following window appears:

1 Add Provides a list of tables (depending on the connection selected) from which to choose.

2 Search Type (part of) the table name, or the table number to search quickly.

3 Buttons Use the >> button to select all fields. By clicking the > button you select one field. Use the < and << buttons to deselect one 
field or all fields, respectively.

4 Fields The Fields tab displays all fields selected for the download.

5 Method Method to present the output of the download eg summed or to retrieve the first or last value from a table.

Create a download definition

As indicated in the introduction to this chapter, a download consists of two parts.
Before you can retrieve data from the system (this also applies to Extensions), you must first specify which data you want to retrieve (creating the 



download definition).
Open the download wizard via the <Dynamic download> button.
The following window appears:

Double click on the Customer table (No. 18). At the top left of the download wizard, an additional tab is added with the name of the selected table.
Open the Customer tab by clicking on it. Instead of a list of tables (Add tab), you will now see a list of fields from the Customer table.



You can add the fields to the download definition by selecting a field on the left and then clicking the single right arrow button.
The same can be achieved with a double-click om that field.

After adding the fields No., Name, Address and City, the screen looks like this:



Now click the <OK> button and the doenload definition below will be created (but not run yet!).



Cell B2 displays the name of the download definition.
Cell C3 indicates from which administration (connection) the data is obtained.
Below this is the table number in cell C4 and the field numbers in cells C6 to C10.

Note: Table and field numbers
The table and field numbers may not be deleted. Exsion Reporting BC works on the basis of these numbers.

After the download definition has been created, it must also be executed.
To do this, click on the  button in the menu bar.<Refresh data>
You will first see a screen in which you must indicate where you want the download to place the data.
The chosen cell will be the top-left corner for the output.

Specify the cell where you want to start the output, and then click .<OK>
The result in this example is as follows:

Filtering

In section 3.2 you made a download that generated a complete customer list as a result.
In this section the download is expanded with a column in which the Sales (LV) field is retrieved.
You then apply a filter so that only customers with a balance greater than €0.00. will be retrieved.



Open the Exsion Reporting BC tab with the download definition you created in section 3.2.
Select a cell in the download definition and click the  button.<Dynamic Download>
You will then be in the download wizard.

Click on the Customer tab and find the Sales (LCY) field (via the search field, see also section 3.2).

In the right window select the City field an then double click on the Sales (LCY) field to add it to the download definition.
Now click the <OK> button. The download definition will then look like this:

In column E, behind Sales (LCY) it now says TRUE.
When a download is extended, the hide option is automatically turned on, because there may be data in the columns to the right of the download 
output.

You are now going to adjust the download definition so that the Sales (LCY) column becomes visible and that the filter is on Sales (LCY) greater 
than €0.00.
Empty cell E11 en put <>0 in cell D11.
It is not necessary to open the download wizard again for this, because you can change this directly on the worksheet.



Then click the <Refresh data> button which results in the following:

Flowfilter in download definition

Section 3.3 describes how a filter can be applied to a download.
In Dynamics BC there are also flow filters that can be applied to flow fields.

There is one flow filter in the Customer table: Date filter. The Sales (LCY) field is a so-called flow field (a calculated field), to which a flow filter 
can be applied.
With a flow filter you can influence the calculation of the flow field. So the calculation is performed in Dynamics BC.

On the Sales (LV) field, you can apply the Date filter flow filter. To do this, you need to open the download wizard again.
Then find the Date Filter field (on the left side of the wizard, Customer tab) and add it to the download definition.
When you click  , you will see the following download definition:<OK>



Since the Date Filter field is a flow filter, it is not necessary to set the hide property to FALSE, because there is no data in this field.
You can now add a date filter to the filter (for filter options, see Appendix 1). This date filter then affects the Sales (LCY) flow field.

Joining tables

It is possible that the data for which you want to make a report is stored in several tables.
Exsion Reporting BC offers the possibility to link (join) tables with each other.
However, this is only possible if there is a unique key between the tables (eg the customer number in the customer and customer ledger tables).

In this section, the principle of joining is explained on the basis of the customer and seller/buyer tables.
The customer table does contain the code of the Seller/Purchaser, but not the full description.
That is because it is in the table Seller/Purchaser.

Open the download wizard by selecting a cell in the download definition (which we edited in section 3.3) and clicking the  <Dynamics Download>
button.
Then, in the download wizard, open the Add tab and locate the Salesperson/Purchaser table.



Double click on the Salesperson/Purchaser table to add it to the download definition.
A join proposal screen will appear before the table is added to the download definition.



In this case there is only one possibility, which is a join between the Salesperson field from the Customer table with the Code field from the 
Salesperson/Purchaser table.
By clicking on <OK> a join type can be selected in the download wizard. When you select a type, the join is created.

Inner Join: 
Only returns the results where a link can be made between both tables.
If no salesperson is entered in the Customer table, then that customer is not included in the output, because no link can be made with the 
Salesperson/Purchaser table.

 Outer Join:
Retrieves all customers, even if no Salesperson is entered.

Inner Top 1: 
See explanation for .Inner Join
Only rtetrieves the first row of the Salesperson/Purchaser table.

Outer Top 1: 
See explanation for .Outer Join
Only rtetrieves the first row of the Salesperson/Purchaser table.

Methode: 
Specifies a specific calculation method to replace functions of the on-premise version of Exsion.
The method can be used for multiple linked tables.
The download definition then looks like this:

You can then add the Name field from the Salesperson/Purchaser table to the download definition:



The fields that have now been added to the download will have the Hide option set to TRUE. The order of the fields can be easily adjusted by 
dragging the fields up or down.
Adjust the order of the fields and make all fields visible, except the Seller field.

Click the <OK> to get the download definition below:

To refresh the output from this download definition, click the <Refresh data> button.
This is part of the output:



Microsoft Dynamics 365 Business Central database

Databasestructure

More than 700 tables are included in the standard version of Dynamics BC. If you want to develop high-quality and fast reports, some knowledge 
of the structure of your own Dynamics BC database is indispensable.
The Exsion Reporting BC function in Dynamics BC database structure helps you find of the way in the database.

When you press the  button in the Exsion Reporting BC tab, select your connection and click the  button you will see <Database structure> <OK>
the screen below.



You now have a map of the database with all tables, fields, indexes and relationships between tables. All tables are so-called hyperlinks. 
The worksheet below will then appear. In the tab of the customer table you can see the name, number, type, length and class of all fields.
Some fields are included as hyperlinks. In this case, there is a relationship between that field and another table in Dynamics BC.
In the Customer table, there is a relationship between Country and the Country/Region table. When you click on Country, you go directly to the 
Country/Region tab.

When you click on the name of a table, you go directly to the corresponding worksheet. For example, click on the "Customer" table.

If there is an option field in your table, you can display it’s values by hovering the mouse over this field. 

Commonly used tables when developing reports



Much of the functionality in Dynamics BC is built around a small number of tables.
These tables are included in the overview below. Most reports are based on one or more of these tables.

Table 15 – G/L Account
Contains information about the general ledger entries.
Table 17 – General Ledger Entry
Contains information about all financial transactions in the database.
Table 18 – Customer
Contains customer information.
Table 21 – Customer Entry
Contains information about customer-related transactions, such as invoices and payments.
Table 379 – Detailed Customer Entry
Contains detailed information about customer related transactions, such as invoices and payments.
Table 23 – Vendor
Contains supplier information.
Table 25 – Vendor entry
Contains information about supplier related transactions, such as invoices and payments.
Table 380 – Detailed Vendor entry
Contains detailed information about supplier related transactions, such as invoices and payments.
Table 27 – Item
Contains item information.
Table 32 – Item Entry
Contains information about all item related transactions (sales/purchase, etc.) in the database. No value information is present in this table.
Table 5802 – Value Entry
Contains information about all value related transactions in the database. All operational data, such as Sales Orders, Purchase Orders and 
Production Orders are stored in a "header/line" relationship.
A sales order consists of a sales header table that contains general information about the order. The sales header table is related to one or more 
sales lines (in the sales line table) that contain information about items, quantities, prices, and so on.

Exploring a flowfield in Dynamics Business Central

There are two ways to find out how a flowfield is calculated.
The first method is to start Dynamics BC.
Then you go to a card that contains the flowfield.

For example, open a customer card:

You can see that the Balance (LCY) field is a green hyperlink.
If you click on the hyperlink, Dynamics BC opens an overview of the Customer Entries:



Clicking on the amount takes you to <Detailed Customer Entries>, where additional information is displayed:

Note: Child table data
When you want to know the name of the child table, you can click on the customer list.
(Keyboard shortcut )CTRL + ALT + F1

Chapter 5 PivotTable

When pivot tables are used, it is possible to update them automatically by clicking the  button.<Refresh data>

Note: 
For automatic updating of a PivotTable, the name of the PivotTable is important.
The name needs to begin with EXSIONBC_

Example:
Create a dynamic download for the table Value entry:



Click the <Refresh data> button and place the download in a new tab:

Open the "Insert" tab.
Click on the button <PivotTable> and create the pivot table:



Now click the <OK> button.

Open the  tab, which belongs to PivotTable Tools."Options"
Click the  button and give the pivot table a name that starts with .<PivotTable> EXSIONBC_

Drag the fields to the correct location:

Complete the pivot table and further format the worksheet.
Now change the filters in the Exsion Reporting BC download and click the  button. <Refresh data>
Exsion Reporting BC will download the new data and adjust the pivot table automatically.
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